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ABSTRACT

ImageJ is capable to read DICOM (Digital Imaging and Communication in Medicine)3 images, the standard
format in medical imaging. But this is not enough: to receive, to send, to compress, to decode, to compare or to
search you need dedicated plugins. This paper reviews the ImageJ features related to DICOM and present the
different existing ImageJ plugins that help to get the problem solved with ImageJ. The demonstration includes
information on how to perform the most important tasks within DICOM Imagery and which commands and
plugins to use. The weaknesses and limitations of ImageJ are discussed as well. The features of the TUDOR
DICOM Tools, a collection of DICOM Plugins for ImageJ are shown including a presentation of the included
DICOM Viewer.
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1. INTRODUCTION

Over the last years the classical, analog medical imaging modalities are more and more replaced by digital image
acquisition technologies. Today Computers have taken an important part in the diagnostic medical imaging.
The mostly used format for storing, transferring and processing these digitalized medical images is the DICOM
(Digital Imaging and Communication in Medicine) standard. The DICOM standard defines an image format as
well as formats for sending, receiving and querying DICOM object (e.g. images) via network. The image format
which does not only contain the pixel data of the acquired image, it also contains meta data about the patient,
the used equipment and the acquisition parameters. This data is stored in tags in the so-called DICOM Header.
Each tag contains a key in the form “0002,0010” and a corresponding value. When working with medical images,
these Meta-data is nearly as important as the image itself to process, store and evaluate the image. Because of
this, all software-solutions working with DICOM images, do allthough have to care about these stored meta-data.

ImageJ, a free Java based image processing software and library is capable of reading DICOM images and
their header data.

This paper will give an overview of the built-in functionalities of ImageJ for working with medical images
and how they can be extended by free available plugins. Afterwords we will show the TUDOR DICOM Tools, a
set of Java libraries developed by our team containing ImageJ plugins and stand-alone applications for working
with DICOM images. These tools combine a lot of needed features to an easy to use set of plugins or a base for
own custom DICOM applications.

2. IMAGEJ BUILT IN FUNCTIONALITIES

ImageJ itself is capable of opening single DICOM images or image stacks from the local harddisk. It uses a
build-in plugin, implemented in the ij.plugin.DICOM class to provide these features. Just like any other image
format DICOM images can be loaded into ImageJ by using the open command (File ⇒ Open) or just dropping
the images onto the application. Image stacks can be loaded by using the import image sequence command
(File ⇒ Import ⇒ Image Sequence). After choosing one of the stack images in a folder, ImageJ will import all
images in this folder into one image stack. During the import you can filter these images by image name or
image number and choose the starting image as well as the number of images to import. The meta-data of the
images, the so-called DICOM-Header is written to the ImagePlus object and can be accessed via the show info
command (Image ⇒ Show.Info)

This built-in plugin is only capable of importing DICOM files with raw, uncompressed image data. Images
with JPEG4 or Lossless Run Length Encoding (RLE) can not be openend. In this case ImageJ will present an



error message while trying to open the image. The type of image compression that is used in the image is coded
in the DICOM header field “Transfer Syntax UID” with code 0002,0010

By now, saving of DICOM images is not supported by ImageJ. The only way to save modified DICOM images
is to export them as TIFF files. In this case ImageJ preserves the DICOM header information by writing it to
the TIFF header.

3. EXISTING PLUGINS

As the built-in functionalities for working with DICOM images are limited, a number of plugins has been
developed by the community to extend these functionalities. Most of these plugins can be found on the ImageJ
homepage1 or the ImageJ Documentation Wiki2

Import Dicom Sequence

Type: Input/Output
Authors: Anthony Padua, Duke University Medical Center, Department of Radiology, Daniel P. Barboriak,
MD, Duke University Medical Center, Department of Radiology
Last Modification: 2005/11/15
Website: http://rsb.info.nih.gov/ij/plugins/import-dicom.html
License: none - Permission to copy, use, and modify for educational and research purposes

The Import Dicom Sequence plugins uses the image number from the DICOM header to sort the files im-
porting an image stack. This might be necessary as the filesnames of the images are not allways sorted in the
same way. If the images are named im1.dcm im2.dcm .... im10.dcm, without this plugin they will be loaded in
the order the filesystem sorts them: im1.dcm, im10.dcm, im2.dcm ..... The functionality of this plugin has been
integrated into ImageJ since version 1.34k which makes it obsolete to install it as a plugin in newer versions.

DICOM Directory Analyzer

Type: Input/Output
Authors: Dirk Scheffler Dep. of Radiooncology, Charite Hospital Humboldt University, Berlin
Last Modification: 2004/08/04
Website: http://rsb.info.nih.gov/ij/plugins/dicom-analyzer.html
License: none

The DICOM Directory Analyzer uses an JFileChooser with an image-preview window with multiselect to
select the files to import. Images belonging to separate series are imported as separate image stacks in ImageJ.
The plugin uses several tags, such as frame of reference UID, image orientation and image position to determine
the stacks. These plugin is quite usefull because of the preview window, as most of the operating system file
managers do not show image an preview for DICOM images.

DICOM Sort

Type: Input/Output
Authors: Thomas Stamm
Last Modification: 2004/05/13
Website: http://rsb.info.nih.gov/ij/plugins/dicom-sort.html
License: none

The DICOM Sort plugin allows the sorted loading of images by image number, image time or acquisition
time, which are read from the DICOM header of the image. It can allthough be used to separate images from
different patients, by using the information displayed log window when a series of images is openend. If a special
way of sorting the images is needed, this plugin might be quite usefull.



DICOM Import and Export Plugins

Type: Input/Output
Authors: Thomas Hacklaender, MD, MSc, Institute for Telematic in Medicine.
Last Modification: 2002/08/22
Website: http://www.iftm.de/telemedizin/dcmimex.htm
License: GNU General Public License

The package contains plugins for importing and exporting DICOM images, as well as plugins for working
with the header information. Images can not only be read or written to a folder on the local harddrive, the
plugins are allthough capable of reading and writing DICOMDIR file-sets. These DICOMDIR file-sets are the
common used format for DICOM CD’s. Additional header information which is normally ignored by ImageJ
is written to special properties of the created ImagePlus objects or stacks to make it accessable within other
plugins or scripts. To archive all this functionality, the plugins make use of the dcm4che5 project, which is a
free available DICOM implementation written in Java. These usage makes the installation of the plugins a bit
complicated, as the Java classpath need to be edited to load the libraries. As the last plugin version is from
2002, it uses the dcm4che version 1.2 libraries from 2002. Do not install this plugin in combination with the
TUDOR DICOM Tools plugin, which uses current dcm4che 2.0 version. As this plugin is distributed under the
GPL License, which will cause licensing problems if used in non-GPL projects.

LOCI Bio-Formats Library

Type: Input/Output
Authors: Curtis Rueden and Kevin Eliceiri
Last Modification: 2008/07
Website: http://www.loci.wisc.edu/ome/formats-imagej.html
License: GNU General Public License / commercial version available

The LOCI Bio-Formats are a Java library which was designed for reading several microscopy file formats.
Besides these formats it is capable of opening DICOM files, even if they use run length encoding or JPEG
compression. The library directly contains ImageJ plugins for opening single images or creating stacks from
a directory full of images. For reading DICOM files with lossless JPEG compression the platform dependent
version of the Java Advanced Imaging API (JAI)6 library needs to be installed into the used Java runtime.
As this plugin is distributed under the GPL License, which will cause licensing problems if used in non-GPL
projects. A commercial version with other license is although available.

Query DICOM Header

Type: Utilities
Authors: Anthony Padua
Last Modification: 2003/05/12
Website: http://rsb.info.nih.gov/ij/plugins/query-header.html
License: none

The Query DICOM Header plugin queries the DICOM header of an opened ImagePlus and writes the header
value of the given header tag field to the result window. As this plugin can be called within a macro, is can be
used to manipulate the image depending on the value of one or more header tag value. E.g. run(”Query Dicom
Header”, ”0008,0060”); will retrieve the creation modality (CT, DR, NM) of the image.

DICOM Rewriter

Type: Utilities
Authors: Walter O’Dell PhD
Last Modification: 2003/09/23



Website: http://rsb.info.nih.gov/ij/plugins/dicom-rewriter.html
License: none

The DICOM Rewriter is a small utility implemented as an ImageJ plugin which allows the anonymization of
DICOM files. After selecting one or more files from a directory, a dialog pops up in which the patient’s name,
patient-id and birthdate can be overwritten with new values. The values are changed directly in the original
images files on the harddisk. The plugin is quite limited, as it is only capable of changing these three header
tags with a maximum length of the original tag value.

4. THE TUDOR DICOM TOOLS

Type: Input/Output, Networking, Utilities, Viewing
Authors: Johannes Hermen, Christian Moll - Public Research Centre Henri Tudor, Luxembourg
Last Modification: 2008/10
Website: http://santec.tudor.lu/projects/optimage/dicomtools/
License: GNU Lesser General Public License (GNU LGPL)

The TUDOR DICOM Tools are a Java library to perform high-level DICOM operations. It is based on
dcm4che version 2,5 the Java Advanced Imaging API (JAI)6 and ImageJ. The library includes stand-alone
applications as well as ImageJ plugins. It can be used as a library in own custom applications as well. It
offers functionality to read and write DICOM files from a disc or a DICOMDIR file-set (e.g. DICOM CD),
work with the DICOM header, anonymize images and send, receive or query images from a Picture Archiving
and Communication System (PACS) via network. The following DICOM network services are provided by the
tools: C-ECHO-SCU/SCP, STORAGE-SCP, QUERY/RETRIEVE-SCU. Additionally it offers components to
view DICOM images with features like windowing, zooming, shifting, measuring etc.. . The ImageJ plugin
contains a small DICOM manager plugin which will open a small toolbar (fig:1) for an easy-access of all the
included components. Most of the included functionalities can be used in ImageJ macros. You can explore how
to use them by using the macro recorder of ImageJ.

Figure 1. TUDOR DICOM Tools - Manager Window

4.1 Reading and writing DICOM Images

The tools offer an extended open dialog (fig:2), with a direct image and configurable header preview of the
selected image. It is capable of reading image files from different sources. It has a built-in DICOM STORE to
receive images via network, functionalities to query and move images from a PACS. The DICOM CD view will
automatically search for valid CD’s in the systems CD-ROM drives. The Image selector view can be used to
filter images in a recursive directory structure by defining matching header tags. Most of the views show the
files structured in patient/study/series to easily find images. Every view allows the selection of single images or
whole series. This dialog is allthough used to manage the files in the local store or to send images from the local
drive, store or CD to another PACS or DICOM entity. With a working version of the JAI framework6 installed
on your system, the plugin will allow you to open DICOM files with JPEG and RLE encoding.

When exporting ImagePlus objects to DICOM files from within ImageJ, the plugin writes the existing header
metadata to the generated DICOM file. If the image does not contain a header, a new, default header will be
created. During the export, the image can be anonymized and tags like patient name and id can be changed.
By now the plugin only supports the creation of uncompressed DICOM files.



Figure 2. TUDOR DICOM Tools - Open Dialog

4.2 Working with the DICOM Header

The library loads the header of each DICOM file into a DicomHeader object, which makes it much easier to
write back the header to exported DICOM files or to retrieve single fields and work with the header information.
An advanced viewing component for the header allows the textual search in the header and the comparison of
headers from different files. Complete directories of DICOM files can be anonymized by deleting the patient,
hospital and/or manufacturer information from the file headers by using the provided anonymizer tool.

4.3 Viewing DICOM Images

The package contains components that offer advanced functionality for viewing DICOM images. While the
ImageJ window needs dialogs and menu commands to window, zoom or shift the image, the DicomImagePanel
uses the mouse-commands for all these things as most of the DICOM viewers do . The mouse-wheel can be used
to run through a stack of images easily. Additionally important information such as patient name and birthday
is extracted from the image header and shown as an overlay on top of the image.

4.4 TUDOR DICOM Viewer

The TUDOR DICOM Viewer started as a tech-demo of all features provided in the TUDOR DICOM Tools.
With the time it evolved to an simple, but jet usefull DICOM viewing application. The viewer is able to display
multiple images in several splitscreen or multi-monitor configurations. Multiple series can be loaded and managed
in the viewer from different available sources. As the viewer allthough contains the complete DICOM open dialog
with the integrated store and send functionalities it can be used not only to view images, but to retrieve images
from one modality, store them into a DICOMDIR that can be burned as DICOM CD or send them to another
DICOM capable modality.



Figure 3. TUDOR DICOM Viewer

5. CONCLUSION

ImageJ is a very powerfull image procession solution. The out of the box DICOM support is quite limited.
This issue can be bypassed by installing additional plugins for special needs and additional features. Most of
the DICOM plugins on the ImageJ plugin page are very specific to dedicated problems and the developers have
stopped working on them. Some plugins conflict with other because of external libraries they require. The
TUDOR DICOM plugins groups most of the functionalities of the other plugins into one package and even offers
a lot of additional features. With some of these plugins installed ImageJ can be used to easily solve specific
problems in an hospital environment and to write custom application with full DICOM support.
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